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OfficeLink Overview

Viewing reports in Microsoft Excel
Creating personalized letters using OfficeLink
OfficeLink templates for personalized letters

Accounting Plus OfficelLink allows you to automatically create word processing and spreadsheet documents
using Accounting Plus data. You must be using OfficeLink-compatible word processing and spreadsheet
programs.
These products are compatible with OfficeLink:

« Microsoft Excel Version 7.0 (Office 95), 8.0 (Office 97) and 2000.

« Microsoft Word Version 6.0, 7.0 (Office 95), 8.0 (Office 97) and 2000.

« Corel WordPerfect Version 8.0 and 9.0.

Viewing reports in Microsoft Excel

While Accounting Plus provides a wide range of reports and graphing tools, there may be times when you'll
find it more convenient to use Microsoft Excel to create what-if scenarios, budgets and the like. With
OfficeLink, you can transfer Accounting Plus reports to Excel as easily as you can print them.

In order to use OfficelLink, you must also be using Microsoft Excel Version 7.0 (Office 95), 8.0 (Office 97) or
Excel 2000. In addition, you must have selected to use Excel when you installed OfficeLink. If you haven't
done this already, reinstall Accounting Plus and select to use Excel with OfficeLink during the installation
process.

If the Excel button in the Index to Reports window is dimmed, OfficeLink hasn't been installed properly for
Excel.

Click below for the step-by-step procedure:

To view Accounting Plus reports in Excel

Modifying OfficeLink templates for Microsoft Excel

To display an Accounting Plus report in Microsoft Excel, Accounting Plus uses a set of special Excel
templates, which are installed when you indicate that you use Excel during the Accounting Plus installation
process. Each Excel template is associated with a specific Accounting Plus report. You can modify these
templates, if you wish.

If you accidentally delete an OfficeLink template for your Excel reports or word processing program's letters,
you can recreate the missing template by reinstalling the Accounting Plus program files. Any missing
templates will be added when you reinstall.

Any templates you've modified won't be replaced when you reinstall Accounting Plus. If you wish to replace
a modified template when you reinstall Accounting Plus, you must first rename or delete the template you
modified. (Refer to the documentation that accompanied your computer for information about renaming and
deleting files using your computer's operating system.)

Click below for the step-by-step procedure:

To modify OfficeLink templates for Microsoft Excel

Creating personalized letters using OfficeLink

From time to time, you may need to send a letter to a customer, reminding him that his payment is late, or



perhaps to tell a customer the items she's ordered are back ordered and will be delayed by a few days.
Using OfficelLink, it's easy to create letters for a single person or several companies-the only requirement is
that they have cards in your Accounting Plus Card File.

In order to use OfficeLink, you must also be using an OfficeLink-compatible word processing program. (See
OfficeLink Overview for a list of compatible programs.) In addition, you must have selected one or more of
these programs when you installed OfficeLink. If you haven't done this already, refer to your Getting Started
manual for general information about reinstalling Accounting Plus to take advantage of OfficeLink's
capabilities.

Even if you haven't installed OfficeLink, you can create a "mail-merge" file that can be used with your word
processing program to create personalized letters. This process is more time-consuming, however. We
recommend that you take advantage of OfficeLink's capabilities if you can. If you choose not to use
OfficeLink, see Exporting data from MYOB Accounting Plus for information about creating an export file of

Accounting Plus information that can be mail-merged into letters and other documents.

Accounting Plus provides a number of letter templates for you to use. If you wish to make permanent
modifications to the templates, see OfficeLink templates for personalized letters and consult the

documentation for your word processing program for instruction on doing so.

Using OfficeLink, you can send personalized letters to any person or company for whom you've created a
card using the Card Information window. You may find this handy for writing collection letters, apologies or
notices that your customer's items have been back ordered.

You can also view a list of all your unpaid receivables-that is, the sales you've entered in Accounting Plus
that your customers haven't fully paid yet. When you've finished viewing the information, you can create
collection letters to send to customers whose payments are overdue.

Click below for the step-by-step procedures:

To send personalized letters to multiple people in your Card File
To send personalized letters to a single person or company

To send personalized letters to customers who have unpaid invoices

OfficeLink templates for personalized letters

When you create personalized letters using OfficeLink, you must choose a template for the letter you're
creating for the customers you select.

Changing the OfficeLink templates

The OfficeLink templates are specially designed to work with your Accounting Plus data and your word
processing software to create personalized letters. Special entries, known as field codes, have been inserted
in these templates to ensure your Accounting Plus data appears in the proper places in your letters. These
field codes are similar, but are not the same, as the typical mail-merge field codes that you would normally
work with in Microsoft Word or Corel WordPerfect. As a result, we recommend that you don't make changes
to any of the field codes in your OfficeLink templates. Also, if you plan to change your templates, we suggest
that you first learn about how your word processing program works with templates.

OfficeLink templates for personalized letters are located in the Letters folder inside the folder in which
Accounting Plus is installed. Letters with the extension .DOT are Microsoft Word templates; letters with the
extension .WPT are WordPerfect templates. We recommend that you make backups of the existing
templates before you begin making changes.

In each template, the format for each Accounting Plus OfficeLink field code is text surrounded by double
brackets, like this:

[[Name]]

If you intend to manually add or change any OfficelLink field codes, be sure the codes use double brackets in



this manner.
Click below for the step-by-step procedure:

To choose an OfficeLink template for personalized letters
Accounting Plus fields that can be merged into OfficeLink

To view OfficelLink field codes

Removing prompts for your name and title from OfficeLink templates

When you use OfficeLink to print mail-merge letters using Microsoft Word or Corel WordPerfect, you'll be
prompted to enter your name and title in a dialog box when the letters are created. Your entries will appear
at the end of your letters. If you're the only person who prints mail-merge letters, however, you may wish
to remove these prompts and place your name and title in the letter templates you use most often.

Click below for the step-by-step procedure:

To modify Microsoft Word templates
To modify Corel WordPerfect templates

OfficeLink Overview
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Important note about changing templates! You must have extensive knowledge about Word or
WordPerfect templates to use the information we've provided here. If you don't feel comfortable with this
information, we strongly encourage you to enlist some assistance from someone who is more knowledgeable
about templates, such as a Certified Consultant.




To view Accounting Plus reports in Excel

If you haven't already read the OfficeLink Overview, see Viewing reports in Microsoft Excel for more
information.

The Index to Reports window should be displayed.
1. Highlight the report you want to display in Excel.

Click Filters to limit the amount of information that appears on the report. The Report Filters window
appears, and you can specify the information you want to see on the report. Click OK.

2. Click the Excel button at the bottom of the Index to Reports window. The report will appear in an
Excel worksheet.

(If you want to view the information on the report in Accounting Plus before opening Excel, click the Display
button, rather than the Excel button; the report will appear in Accounting Plus's Screen Reports window.
When you're ready to view the report in Excel, click the Excel button in the Screen Reports window.)

3. In Excel, make any changes you like to the report information.

To view Accounting Plus reports in Excel
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Warning: Avoid exiting Accounting Plus while exporting reports using OfficeLink While you are
exporting Accounting Plus reports to Excel using OfficeLink, it's very important that you don't use the
Windows Task Manager to close either Accounting Plus or the DRVXL16.exe program. If you exit either
Accounting Plus or the DRVXL16.exe program using the Task Manager before all the report information has
been transferred from Accounting Plus to Excel, a General Protection Fault error will occur. We strongly
recommend that you wait until the report information has been transferred to Excel before attempting to
exit Accounting Plus. Note: If you want to view the Cash Flow Analysis Report in Excel In order to
view the Accounting Plus Cash Flow Analysis report in Excel, you must first display the Cash Flow
Worksheet. If you choose the Cash Flow Analysis report in the Index to Reports window, then click Excel, a
message will appear to alert you about this requirement. Click OK and the Cash Flow Worksheet window will
be displayed for you automatically. Click the Analyze Cash Needs button in that window, then click the Excel
button in the Index to Reports to view the report in Excel.



file:///C|/^^^^^US 10 PDFs/PDFOutput/640000c.fm

To modify OfficeLink templates for Microsoft Excel

If you haven't already read the OfficeLink Overview, see Modifying OfficeLink templates for Microsoft Excel
for more information.

Click below for a list of Accounting Plus reports and their corresponding Excel templates:
General Ledger Tab

Checkbook Tab

Sales Tab

Time Billing Tab

Purchases Tab

Payroll Tab

Inventory Tab

Card File Tab

To modify OfficelLink templates for Microsoft Excel

© MYOB Limited. All rights reserved.

Warning: Use caution when modifying Accounting Plus's Excel templates! If you modify the Excel
templates for your Accounting Plus reports, be sure that you do not move the [[Tbl:Body Table]] field. This
field must be located in Column B, row 15, in order for each report's total amounts to be calculated
correctly. If you move [[Tbl:Body Table]], the totals will be inaccurate.

Also note that you cannot directly reference a specific piece of data within a report when creating additional
calculations on your report data. This is because Excel will push the reference field you create to a field
below the end of the report body when the report is imported into Excel. As an alternative, we suggest that
you either create a macro that will be calculated after the report is imported or place your reference field on
a separate spreadsheet that will be updated after the report is imported.



General Ledger Tab

Report Template File Name
Account History (OfficeLink) accthist.xlt
Account Inquiry accting.xlt
Balance Sheet balsht.xlIt
Balance Sheet (Spreadsheet) balshts.xlt
Balance Sheet (Budget Spreadsheet) balshtbs.xlt
Balance Sheet (Last Year Analysis) balshtla.xlt
Balance Sheet (Budget Analysis) balshtba.xlt
Chart Of Accounts (Summary) coasum.xlt
Chart Of Accounts (Detail) coadet.xlt
Currency List curlst.xlt
Currency Realized Gain/Loss curre.xlt
Currency Unrealized Gain/Loss curunre.xlt
General Journal genjril.xlt
GST and PST Return gstreg.xlt
Job Activity (Summary) jobacts.xlt
Job Activity (Detail) jobactd.xlt
Job Budget History (OfficeLink) jobbudhi.xlt
Job History (OfficeLink) jobhist.xlt
Job Inquiry jobing.xIt
Job Profit & Loss jobpl.xlt
Job Reimbursable Expenses jobreexp.xlt
Jobs (Budget Analysis) jobba.xlt
Jobs List joblist.xlt
Profit & Loss pl.xlt
Profit & Loss (Spreadsheet) pls.xlt
Profit & Loss (Budget Spreadsheet) plbs.xlt
Profit & Loss (with Year to Date) plytd.xlt
Profit & Loss (with Last Year) plly.xlIt
Profit & Loss (% Sales Analysis) plsa.xlt
Profit & Loss (Last Year Analysis) pllya.xlt
Profit & Loss (Budget Analysis) plba.xlt
Recurring General Journal Entry recgj.xlt
Session Report session.xlt
Trial Balance (Summary) tribas.xlt
Trial Balance (Detail) tribald.xlt

OfficeLink Templates - General Ledger Tab
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Checkbook Tab

Report Template File Name
Cash Disbursements Journal cdjrnl.xlt

Cash Flow Analysis cashflw.xlt

Cash Receipts Journal crjrnl.xlt

Checkbook Register chkbkreg.xlt
Reconciliation Report reconcil.xlt

Bank Deposit bdr.xlt

Recurring Checks recchk.xlt

Recurring Deposits
To Do List (Recurring Transactions)

OfficeLink Templates - Checkbook Tab
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recdep.xlt
tdirectn.xlt



Sales Tab
Report

Aged Receivables (Summary)

Aged Receivables (Detail)

Analyze Sales (Item)

Analyze Sales (Item - FY Comparison)
Analyze Sales (Item Spreadsheet)

Analyze Sales (Activity)

Analyze Sales (Activity - FY Comparison)
Analyze Sales (Activity Spreadsheet)
Analyze Sales (Customer)

Analyze Sales (Customer - FY Comparison)
Analyze Sales (Customer Spreadsheet)
Analyze Sales (Salesperson)

Analyze Sales (Salesperson - FY Comparison)
Analyze Sales (Salesperson Spreadsheet)
Customer Payment (Closed Invoices)
Customer Payments (Salesperson)
Customer Reimbursable Expense

Invoice Inquiry

Receivables Reconciliation (Summary)

Receivables Reconciliation (Detail)
Recurring Sales Templates

Referral Source

Sales & Receivables Journal

Sales (Customer Summary)

Sales (Customer Detail)

Sales History by Customer (OfficeLink)
Sales History by Salesperson (OfficeLink)
Sales (Salesperson Summary)

Sales (Salesperson Detail)

Sales (Activity Summary)

Sales (Activity Detail)

Sales (Item Summary)

Sales (Item Detail)

Sales Register (All Sales)

Sales Register (Closed Invoices)

Sales Register (Open Invoices and Orders)
Sales Register (Quotes)

Sales Register (Returns and Credits
Sales Tax (Summary)

Sales Tax (Summary - Cash)

Sales Tax (Detail)

Sales Tax (Detail - Cash)

Sales Tax Exceptions (Checkbook)
Sales Tax Exceptions (Sales/Purchases)
Tax Code List

To Do List (Receivables)

To Do List (Recurring Sales)

To Do List (Orders to be Shipped & Received)

OfficeLink Templates - Sales Tab
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Template File Name
agedars.xlt
agedard.xlt
zsalit.xIt
zsalitly.xlt
zsalits.xlt
zsalac.xlt
zsalacly.xlt
zsalits.xlt
zsalc.xlt
zsalcly.xlt
zsalcs.xlt
zsalsp.xlt
zsalsply.xIt
zsalsps.xlt
custpyh.xlt
custpysp.xlt
custrexp.xlt
inving.xlIt
arrecsum.xlt

arrecdtl.xlt
recsale.xlt
ingsrc.xlIt
salejrnl.xlt
salcusts.xlt
salcustd.xlt
salhiscu.xlt
salhissp.xlt
salsps.xlt
salspd.xlt
salacts.xlt
salactd.xlt
salitms.xIt
salitmd.xIt
srall.xlt
srclol.xlt
srinvor.xlt
srquo.xlt
srcred.xlt
saltxs.xlt
saltxsc.xlt
saltxd.xlt
saltxdc.xlt
tcect.xlt
tceit.xlt
txcodlst.xlIt
tdlar.xlIt
tdircsal.xlIt
tdlordrs.xlt



Time Billing Tab

Report Template File Name
Activity List actlist.xlt

Activity Log Detail actlogdl.xlt

Activity Log Diary actlogdy.xlt

Activity Slip (Activity Detail) asactdet.xlt

Activity Slip (Activity Summary) asactsum.xlt

Activity Slip (Customer Detail) ascusdet.xlt

Activity Slip (Customer Summary) ascussum.xlt

Activity Slip (Employee Detail) asempdet.xlt

Activity Slip (Employee Summary) asempsum.xlt

Hourly Productivity (Detail)
Hourly Productivity (Summary)
Rate Exceptions

OfficeLink Templates - Time Billing Tab
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hrprodd.xlt
hrprods.xlt
rateexcp.xlt



Purchases Tab

Report

Aged Payables (Detail)

Aged Payables (Summary)

Analyze Purchases (Item Spreadsheet)
Analyze Purchases (Vendor FY Comparison)
Analyze Purchases (Vendor Spreadsheet)
Analyze Purchases (Vendor)

Bill Inquiry

Payables Reconciliation (Detail)

Payables Reconciliation (Summary)
Purchase History by Vendor (OfficeLink)
Purchases & Payables Journal

Purchases (Item Detail)

Purchases (Item Summary)

Purchases Register (All Purchases)
Purchases Register (Closed Bills)
Purchases Register (Open Bills and Orders)
Purchases Register (Quotes)

Purchases Register (Returns and Debits
Purchases (Vendor Detail)

Purchases (Vendor Summary)

Template File Name

agedapd.xlt
agedaps.xlt
zpurits.xlt
zpurvly.xlt
zpurvs.xlt
zpurv.xlt
poing.xIt
aprecond.xlt
aprecons.xlt
purhisv.xlt
papjrnl.xIt
puritmd.xlt
puritms.xlt
prall.xlt
prclol.xlt
prbilor.xlt
prquo.xlt
prcred.xlt
purvendd.xlt
purvends.xlt

Recurring Purchase Templates recpo.xlt
To Do List (Expiring Discounts) tdlexpd.xlt
To Do List (Payables) tdlap.xlt

To Do List (Recurring Purchases) tdlrecpr.xlt
Vendor Payment History vdrpyh.xlt

Vendor Payments vdrpyt.xlt

OfficeLink Templates - Purchases Tab
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Payroll Tab

Report Template File Name
Employee Payroll List empyrist.xlt
Employer Accrual Expense Balance (Detail) empexpbd.xlt
Employer Accrual Expense Balance (Summary) empexpbs.xlt
Insurable Earnings insureng.xlt
940 Report 940.xlt

941 Report 941.xlt
Accrual Balance (Summary) aclbals.xlt
Accrual Balance (Detail) aclbald.xlt
Employee Payroll List empyrist.xlt
Payroll Activity (Summary) payacts.xlt
Payroll Activity (Detail) paycatd.xlt
Payroll Category Inquiry paycatiq.xlt
Payroll Earnings pradv.xlt
Payroll Journal payjrnl.xlt
Payroll Register (Summary) payregs.xlt
Payroll Register (Detail) payregd.xlt
Payroll Summary paysum.xlt
Quarterly Tax Totals qtrtt.xlt
Recurring Paychecks recpychk.xlt
RL-1 Summary releves.xlt
T4 Summary tfours.xlt
Tax Detail (Employee) txdetemp.xlt
Tax Liabilities taxliab.xlIt

OfficeLink Templates - Payroll Tab
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Inventory Tab

Report

Analyze Inventory (Summary)
Analyze Inventory (Detail)
Auto Build

Inventory Count Sheet
Inventory Journal

Item Sales History (OfficelLink)
Items List (Summary)

Items List (Detail)

Price Analysis

Price List (Summary)

Price List (Detail)

To Do List (Stock Alert)

OfficeLink Templates - Inventory Tab

© MYOB Limited. All rights reserved.

Template File Name
zinvs.xlt
zinvd.xlt
autobld.xlt
invctst.xlt
invjrnl.xIt
itemsalh.xlt
itmls.xlt
itmld.xIt
pricez.xlt
prclsst.xlt
prclsstd.xlt
tdlsa.xlt



Card File Tab

Report

Address List

Card File (Summary)

Card File (Detail)

Card Inquiry

Contact Log

Identifiers

To Do List (Overdue Contacts)

OfficeLink Templates - Card File Tab
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Template File Name
addlst.xlt

cfsum.xlt

cfdet.xlt

cfing.xlt

clog.xlt

ids.xlt

tdloc.xlt



To send personalized letters to multiple people in your Card File

If you haven't already read the OfficeLink Overview, see Creating personalized letters using OfficeLink for
more information.

If you're not using OfficeLink, see Exporting data from MYOB Accounting Plus for information on creating an
export file that can be used to create mail-merge letters.

The Forms Selection - Personalized Letters window should be displayed.

1. Make selections about the data you want to export and then click OK. The Review Cards Before
Exporting window appears.

2. All cards whose data fit the criteria you entered in the Personalized Letters window appear in the list
with a mark in their Export field.
If you don't want to export the data for a card, click the mark in its Export field to remove the mark.
3. Click Mail Merge.
4. The Select From List window appears with a list of letter templates you can use to create
personalized letters for the customers you've selected.
Highlight the template you want, and click the Use Template button.

(See To choose an OfficeLink template for personalized letters for a list of letter templates available for use
with OfficeLink.)

5. Your word processor will open, and a series of dialog boxes will appear, allowing you to enter
additional information that will appear in the letters. For all letters, you'll be asked to enter your
name and business title.

I f you're printing letters to alert your customers that some of their items are on back order, using the
BACKORD template, you also will be asked to indicate the items that are on back order.

If you enter multiple items, they will be printed in a column; to ensure that they appear properly, we
suggest that you make your entries in the dialog box in the following format:

#WP-FLO Floral Wallpaper
#WP-GEO Geometric Wallpaper

If you're printing letters to alert customers that the checks they used to pay you have bounced, using the
BOUNCED template, you'll be asked to specify the check humber and the amount for each customer you've
selected.

When you've made all the entries required, the personalized letters for the customers you selected will be
displayed. You can edit these letters, if you like, or print them just as they are.

To send personalized letters to multiple people in your Card File
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Warning: Some templates shouldn't be used or changed OfficeLink uses several templates and macros
to create personalized letters, and some of these templates shouldn't be used to create letters, changed or
deleted.

If you are using Microsoft Word, avoid using or changing the MYOBMAIN.DOT or MYOBMN97.dot template.

If you are using WordPerfect, avoid using or changing the MYOBFILL.WCM and MYOBGTAG.WCM macros.
Note: The items you enter in the dialog box will be used on all the letters you've selected You can
enter more than one item in the dialog box that appears when your word processing program is started. It's
important to note, however, that whatever entries you make in the dialog box will be used for every letter
you've selected. Using the example above, every customer you've selected will be told that their geometric
wallpaper and floral wallpaper are on back order.

If some customers have ordered another combination of items that are back ordered, you'll need to repeat
this procedure for those customers. Following our example, you might create one set of letters for people
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who ordered geometric wallpaper, a second set of letters for those who ordered floral wallpaper, and a third
set of letters for those who ordered both types of wallpaper.



To send personalized letters to a single person or company

If you haven't already read the OfficeLink Overview, see Creating personalized letters using OfficeLink for
more information.
The Cards List window should be displayed.

1. Click on the name you want to highlight it.

2. Click the Letter button at the bottom of the window.

3. The Select From List window will appear with a list of letter templates you can use to create
personalized letters for the person or company you've selected.

Highlight the template you want, then click the Use Template button.

See To choose an OfficeLink template for personalized letters for a list of letter templates available for use
with OfficeLink.

4. Your word processor will open, and a series of dialog boxes will appear, allowing you to enter
additional information that will appear in the letter. For all types of letters, you'll be asked to enter
your name and business title.

If you're printing a letter to alert your customer that some of their items are on back order, using the
BACKORD template, you also will be asked to indicate the items that are on back order.

If you enter multiple items, they will be printed in a column; to ensure that they appear properly, we
suggest that you make your entries in the dialog box in the following format:

#WP-GEO Geometric Wallpaper
#WP-FLO Floral Wallpaper

If you're printing a letter, using the BOUNCED template, to alert a customer that the check they used to pay
you has bounced, you'll be asked to specify the check humber and the amount of the check that bounced.

When you've made all the entries required, the personalized letter for the customer you selected will be
displayed. You can edit this letter, if you like, or print it just as it is.

To send personalized letters to a single person or company
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Warning: Some templates shouldn't be used, changed or deleted OfficeLink uses several templates to
create personalized letters, but some of these templates shouldn't be used, changed or deleted.

If you are using Microsoft Word, avoid using, changing or deleting the MYOBMAIN.DOT or MYOBMN97.DOT
template.

If you are using WordPerfect, avoid using, changing or deleting the MYOBFILL.WPT or MYOBGTAG.WPT
macros. Note: The items you enter in the dialog box will appear on all the letters you've selected
You can enter more than one item in the dialog box that appears when your word processing program is
started. It's important to note, however, that whatever entries you make in the dialog box will be used for
every letter you've selected. Using the example above, every customer you've selected will be told that their
geometric wallpaper and floral wallpaper are on back order.

If some customers have ordered another combination of items that are back ordered, you'll need to repeat
this procedure for those customers. Following our example, you might create one set of letters for people
who ordered geometric wallpaper, a second set of letters for those who ordered floral wallpaper, and a third
set of letters for those who ordered both types of wallpaper.
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To send personalized letters to customers who have unpaid invoices

If you haven't already read the OfficeLink Overview, see Creating personalized letters using OfficeLink for
more information.

If you're not using OfficeLink, see page Creating personalized letters using exported data for information on

creating an export file that can be used to create mail-merge letters for your customers with unpaid
invoices.

The To Do List window should be displayed.

1. Click the A/R (Accounts Receivable) tab to display a list of all your unpaid receivables.

2. If you want to view detail about a specific sale, click the zoom arrow to the left of the customer's
name.

3. Click the Action column for each customer in the list to whom you want to send a letter.
4. Click the Mail Merge button at the bottom of the window.

5. The Select From List window appears with a list of letter templates you can use to create
personalized letters for the customers you've selected. Accounting Plus provides four templates for
collection letters. Highlight the template you want from the following list, and click the Use Template
button.

See To choose an OfficeLink template for personalized letters for a list of letter templates available for use
with OfficeLink.
6. Your word processor will open, and a series of dialog boxes will appear, allowing you to enter your
name and business title.

When you've made all the entries required, the personalized letters for the customers you selected will be
displayed. You can edit these letters, if you like, or print them just as they are.

To send personalized letters to customers who have unpaid invoices
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Warning: Some templates shouldn't be used, changed or deleted OfficeLink uses several templates to
create personalized letters, but some of these templates shouldn't be used, changed or deleted.

If you are using Microsoft Word, avoid using, changing or deleting the MYOBMAIN.DOT or MYOBMN97.DOT
template.

If you are using WordPerfect, avoid using, changing or deleting the MYOBFILL.WPT or MYOBGTAG.WPT
macros.
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To choose an OfficeLink template for personalized letters

If you haven't already read the OfficeLink Overview, see OfficeLink templates for personalized letters for
more information.

You must have extensive knowledge about Word or WordPerfect templates to change your templates in
Accounting Plus. If you don't feel comfortable with this information, we strongly encourage you to enlist
some assistance from someone who is more knowledgeable about templates, such as a Certified Consultant.

Choose a template from the list below:

Apology letter
Backorder letter
Blank letter

Bounced check letter
First collection letter
Second collection letter
Third collection letter
Final collection letter
Fax cover page
Resolution letter
Thank you letter

To choose an OfficeLink template for personalized letters

© MYOB Limited. All rights reserved.



Apology letter
Template names:

APOLOGY.DOT (Word)
6APOLOGY.WPT (WordPerfect V.6)
APOLOGY.WPT (WordPerfect V.8 and V.9)

Use this letter template to apologize for a problem your company has caused for a customer, and to assure
the customer that the problem will be addressed.

Infotech Consulting

254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Please accept my sincere apology, on behalf of InfoTech Consulting for the difficulties we've caused you.
We've made a sincere effort to address your problem, and we hope that you find the resolution satisfactory.
Please contact me directly if you have any remaining issues or questions; it's important to me that your
concerns are fully addressed.

Sincerely,

Mark Davidson
Vice President

Apology letter
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Backorder letter
Template names:

BACKORDR.DOT (Word)
BACKORD.WPT (WordPerfect V.8 and V.9)

Use this letter template to let your customers know the items they've ordered are on back order and will be
shipped as soon as possible.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Thank you for the order you placed. Unfortunately, the following item(s) you've ordered are currently on
back order with our supplier:

We expect these items to arrive shortly, and we'll ship your order as soon as they do.
If you have any questions or you'd like to make a change to your order, please call us. We appreciate your
business, and we apologize for any inconvenience this delay causes you.

Sincerely,

Mark Davidson
Vice President

Backorder letter
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Blank letter
Template names:

BLANK.DOT (Word)

BLANK.WPT (WordPerfect V.8 and V.9)

Use this letter format when none of the other Accounting Plus templates meet your needs and you wish to
write your own letter. The following information for the selected person or company will appear in your word
processing document: contact name, company name, address, city, state, zip code and salutation. In
addition, your company name and address will appear at the top of the document.

Blank letter
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Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00
Dave Bertrand
Bertrand Engineering

915 Rock River Way
Parsippany, New Jersey 07860

Dear Dave:

(Insert your own text here in this space of the Blank Template.)

Sincerely,

Mark Davidson
Vice President




Bounced check letter
Template names:

BOUNCECK.DOT (Word)
BOUNCED.WPT (WordPerfect V.8 and V.9)

Use this letter template for customers whose payment checks have been returned to you marked "NSF"
(non-sufficient funds).

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

'Your bank has returned your check, number 5001, for $1,000 to us. The bank indicated that your account
doesn't have sufficient funds to pay the check.

In order for you to keep your account with us in good standing, it's important that you make payment
within 3 days. We ask that you use the enclosed envelope to make your payment., and we ask that you
make your payment using a certified check, money order or cashier's check. (If the overdraft occurred
because of a bank error, please simply send a replacement check.)

If you're unable to make a full payment or if you have questions about the returned check, please call
immediately. We will work with you, if need be, to find a solution that allows you to keep your good credit
standing with us.

Sincerely,

Mark Davidson
Vice President

Bounced check letter
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First collection letter
Template names:

COLL_1ST.DOT (Word)
COLL_1.WPT (WordPerfect V.8 and V.9)

Use this letter template for customers whose accounts have become past due. This letter serves as a gentle
reminder to your customers to bring their account balance up to date.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Our records show that your current balance with us is $1,866.56, of which $1,866.56 is nhow past due. We
hope this is merely an oversight on your part. If you haven't already sent a payment for the past due
amount to us, please do so today. If a problem has arisen that we should be aware of, please call us
immediately to discuss it.

We value your business, and we'd like for you to resolve this issue as quickly as possible.

Sincerely,

Mark Davidson
Vice President

First collection letter

© MYOB Limited. All rights reserved.



Second collection letter
Template names:

COLL_2ND.DOT (Word)
COLL_2.WPT (WordPerfect V.8 and V.9)

This letter template expresses greater urgency than COLL_1ST and requests that your customer contact you
immediately.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860
10/4/00

Dave Bertrand
Bertrand Engineering
15 Rock River Way
Parsippany, NJ 07860
Dear Dave:

Is there a reason we have not heard from you? Your overdue balance is now $1,866.56 and is long past
due. This is beginning to concern us. Please let us hear from you at once.

Sincerely,

Mark Davidson

Vice President

Second collection letter
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Third collection letter
Template names:

COLL_3RD.DOT (Word)
COLL_3.WPT (WordPerfect V.8 and V.9)

This letter template is similar to COLL_2ND, but expresses even greater urgency, and encourages the
customer to take action before his credit history is damaged.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand

Bertrand Engineering

915 Rock River Way

Parsippany, NJ 07860

Dear Dave:

We have not yet received your overdue balance of $1,866.56. Please contact us immediately.

We'd like to continue thinking of you as a valued customer. We'd prefer not to damage our relationship by
turning your account over to a collection agency. However, we will do so if we don't receive payment from
you immediately.

If you've already sent the payment, please call us. If you haven't done so, please send your payment in full
today.

Sincerely,

Mark Davidson
Vice President

Third collection letter

© MYOB Limited. All rights reserved.



Final collection letter
Template names:

COLL_FIN.DOT (Word)
COLL_FI.WPT (WordPerfect V.8 and V.9)

This letter template is the most strongly worded of the Accounting Plus collection letters. It indicates that
you will turn the customer's account over to a collection agency if payment isn't made within a specified
number of days.

Infotech Consulting
254 Willow Street
Parsippany, New Jersey 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Despite our previous efforts to settle this matter, your account remains unpaid and is long overdue. Unless
we receive full payment of $1,866.56, we will turn your account over to our collection agency for collection.

As you know, such action is likely to damage your credit rating and your ability to do business with other
companies. We don't wish for that to happen. We've enjoyed doing business with you, but we really must
settle your account.

If you call me, we may be able to find a solution that allows you to make payment and avoid the
unpleasantness of the collection process. I urge you to call me today.

Please call today or make immediate payment in full. Otherwise, I will turn your account over to our
collection agency.

Sincerely,

Mark Davidson
Vice President

Final collection letter
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Fax cover page

Template names:

FAXCOVER.DOT (Word)

FAXCOVR.WPT (WordPerfect V.8 and V.9)

Use this letter template to create a fax cover page for the people or companies you've selected. This page
includes room for a memo, should you wish to include one.

Fax cover page
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FAX Cover Page

To:

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Fax:
973-555-2345

From:

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860
973-555-5555

Date:
10/4/00

Pages:

Memo:
(This is where you can add a memo should you wish to include one)




Resolution letter
Template names:

RESOLVED.DOT (Word)
RESOLUT.WPT (WordPerfect V.8 and V.9)

Use this letter format for customers who have questioned an amount on their monthly statement. This letter
indicates that you are looking into the matter and that you will credit the customer's account for the amount
in question while the matter is investigated.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Thanks for alerting us to your concerns about your statement. We are researching the changes on the
statement, and we expect to contact you shortly with a resolution to the problem. In the meantime, we've
credited your account for the amount in question.

Please feel free to call me if you have any further questions about this matter, or if I can assist you in some
other way.

Sincerely,

Mark Davidson
Vice President
Resolution letter
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Thank you letter
Template names:

THANKYOU.DOT (Word)
THANKYO.WPT (WordPerfect V.8 and V.9)

Use this letter to thank new customers for their business.

Infotech Consulting
254 Willow Street
Parsippany, NJ 07860

10/4/00

Dave Bertrand
Bertrand Engineering
915 Rock River Way
Parsippany, NJ 07860

Dear Dave:

Please call me if I can assist you in any way.

Sincerely,

Mark Davidson

Thanks for choosing us! We appreciate your business and the opportunity to serve you. We know you could
have chosen one of our competitors, and we're delighted and honored that you've chosen to work with us
instead. I trust we'll meet or exceed your expectations in the coming months and years.

Thank you letter
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Accounting Plus fields that can be merged into OfficeLink

If you haven't already read the OfficeLink Overview,

information.

see Changing the OfficeLink templates for more

Only a specific number of Accounting Plus fields are available for use in the OfficeLink templates. You must
have extensive knowledge about Word or WordPerfect templates to use the information we've provided
here. If you don't feel comfortable with this information, we strongly encourage you to enlist some
assistance from someone who is more knowledgeable about templates, such as a Certified Consultant.

The following Accounting Plus fields can be merged into OfficeLink templates.

Accounting Plus field

[[Company]]
[[Cadd1]]
[[Cadd2]]
[[Cadd3]]
[[Cadd4]]

[[CPhone]]

[[Name]]

[[Add1]]
[[Add2]]
[[Add3]]
[[Add4]]
[[Add5]]
[[City1]]
[[State1]]
[[ZIP1]]

[[Sadd1]]

[[Sadd2]]

[[Sadd3]]

[[Sadd4]]

[[Sadd5]]

[[City2]]

Where the field is located in Accounting
Plus

Company Name field in the Company Information
window

First line of the Address field in the Company
Information window

Second line of the Address field in the Company
Information window

Third line of the Address field in the Company
Information window

Fourth line of the Address field in the Company
Information window

Phone Number field in the Company Information
window

Company Name field in the Card Information window
for companies; Last Name and First Name fields in the
Card Information window for individuals

First line of the Address 1 field in the Card
Information window

Second line of the Address 1 field in the Card
Information window

Third line of the Address 1 field in the Card
Information window

Fourth line of the Address 1 field in the Card
Information window

Fifth line of the Address 1 field in the Card
Information window

The City field of the Address 1 field in the Card
Information window

The state field of the Address 1 field in the Card
Information window

The zip code field of the Address 1 field of the Card
Information window

First line of the Address 2 field in the Card
Information window (used for customers and vendors
only)

Second line of the Address 2 field in the Card
Information window (used for customers and vendors
only)

Third line of the Address 2 field in the Card
Information window (used for customers and vendors
only)

Fourth line of the Address 2 field in the Card
Information window (used for customers and vendors
only)

Fifth line of the Address 2 field in the Card
Information window (used for customers and vendors
only)

The City field of the Address 2 field in the Card
Information window (used for customers and vendors
only)



[[State2]]

[[ZIP2]]

[[Phonel]]
[[Phone2]]

[[Fax]]
[[Salutation]]

[[Contact]]
[[Balance]]

[[Overdue]]

The state field of the Address 2 field in the Card
Information window (used for customers and vendors
only)

The zip code field of the Address 2 field in the Card
Information window (used for customers and vend<|)r§
only

Phone #1 field in Address 1 in the Card Information
window

Phone #2 field in Address 1 in the Card Information
window

Fax field in Address 1 in the Card Information window
Salutation field in Address 1 in the Card Information
window

Contact field in Address 1 in the Card Information
window

The balance, in dollars, of customers' and vendors'
accounts, as calculated by Accounting Plus

The overdue balance, in dollars, of customers and
vendors, as calculated by Accounting Plus

Accounting Plus fields that can be merged into OfficeLink
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To view OfficelLink field codes

If you haven't already read the OfficeLink Overview, see OfficeLink templates for personalized letters for
more information.

In Microsoft Word, you can choose Options from the Tools menu to display the Options window. To view field
codes, mark the Field codes option and click OK.

In Corel WordPerfect, you can view field codes simply by opening a template. Depending upon how your
system is set up, the field codes may be displayed in a different color.

To view OfficeLink field codes
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To modify Microsoft Word templates

If you haven't already read the OfficeLink Overview, see Removing prompts for your name and title from
OfficeLink templates for more information.

1. Start Microsoft Word.
2. Choose Open from the File menu. The Open dialog box will appear.

3. Using this dialog box, locate your Accounting Plus software folder, then locate the Letters folder
within it. Display the contents of this folder.

4. Choose All Files from the Files of Type field. All your OfficeLink letter templates will appear.

5. Highlight the template you wish to modify, and click Open. The template you selected will open.
If you're unsure about which template you want, see To choose an OfficeLink template for personalized
letters for descriptions of OfficelLink letter templates.

6. Choose Options from the Tools menu; the Options window will appear.

7. Click the View tab. If the Field Codes option isn't marked, mark it, then click OK. When this option is
marked, a number of hidden fields will appear in your template.

8. Locate the following fields at the bottom of the template, and delete them:

{ FILLIN "Enter your Name:"\o }
{ FILLIN "Enter your title:"\o }

9. Type your name and title at the bottom of the letter.
10. Choose Save from the File menu.

To modify Microsoft Word templates
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To modify Corel WordPerfect templates

If you haven't already read the OfficeLink Overview, see Removing prompts for your name and title from
OfficeLink templates for more information.

1.
2.
3.

4.

Start Corel WordPerfect.
Choose Open from the File menu. The Open dialog box will appear.

Using this dialog box, locate your Accounting Plus software folder, then locate the Letters folder
within it. Display the contents of this folder.

Choose WP Templates (*.wpt) from the For Type field. All your OfficeLink letter templates for
WordPerfect will appear.

Locate the template you wish to modify, and make a note of its name; you'll need this information in
a later step. Highlight the template and click Open. The template you selected will open.

If you're unsure about which template you want, see To choose an OfficeLink template for personalized
letters for descriptions of OfficelLink letter templates.

6.

7.

A dialog box will appear, asking for your name and title (and other information, possibly, depending
upon the template you've chosen). Choose Cancel.

Locate the following fields at the bottom of the template, and type your name and title in their place.
Don't put brackets around the text you enter.

[Please Enter Your Name]
[Please Enter Your Title]

Choose Save As from the Edit menu. The Save As dialog box will appear. Save the document using a
name other than the template's earlier name (the name we asked you to note in step 5). That way,
you'll be able to use the original template again in the future if you wish to do so. Be sure your
modified template has a .wpt extension, and be sure to save it in the Letters folder inside your
Accounting Plus software folder.

To modify Corel WordPerfect templates
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